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Target audience for this paper

e Users of software instructed to provide a data medium/data package pursuant to
GDPdU/GoBD.

o Developers of software providing tax relevant data for data carrier cession pursuant to
GDPdU/GoBD.

Summary/objective

Pursuant to § 147 paragraph 6 AO (German Fiscal Code), internal revenue is entitled to audit
the data of electronic accounting systems “digitally” either through data carrier cession and/or
through indirect or alternatively direct access.

For data carrier cession, the data must be provided in a “machine-analyzable form” by the
business subject to taxation (or by the commissioned tax advisor, accounting
firm/subcontractor etc.) on suitable data media.

The term “machine-analyzability” from the perspective of internal revenue refers to optional
access to all stored data, including the master data and links with sorting and filtering
functions.

In order to achieve such analyzability and usability, it is necessary to define and standardize
the file formats for data carrier cession.

This document presents a procedure to facilitate the defined and standardized data carrier
cession and to outline a standard for the software industry.

Should you have any queries, please write to sales.de@caseware.com, or obtain
information from https://www.caseware.net (in German).
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Text of § 147 paragraph 6 AO (German Fiscal Code)

In the version of the act to lower tax rates and to reform business taxation (Tax Reduction
Act — StSenkG) of 23/10/2000, BGBI. (Federal Gazette) | 2000, p. 1433 (non-official
translation):

(6) In the event that documentation has been prepared pursuant to paragraph 1 with the aid
of a data processing system, internal revenue, within the scope of an external audit, has
the right to view stored data and to use the data processing system to audit such
documentation. Within the scope of an external audit, internal revenue can also require
that the data be analyzed automatically as specified by it, or that the stored data and
copies be made available to it on a machine-utilizable data medium. The costs involved
are borne by the party subject to taxation.

Data carrier cession

A possible scenario for a tax audit involving a data carrier cession:

An auditor is commissioned to audit a business. For specific auditing fields and auditing
periods, the auditor decides to analyze the data with the aid of auditing software.
Accordingly, the business concerned will be provided with notice of the audit and will be
notified of the areas on which the audit will concentrate. He or she requests the business to
make the tax relevant data available on a machine-analyzable data medium as specified by
the “Principles of data access and auditing of digital documents” (GDPdU) pursuant to the
German Federal Ministry of Finance communication of 16/07/2001 and the “Principles of duly
keeping and retaining accounting books, records and documents in electronic form and of
accessing data” (GoBD) pursuant to the German Federal Ministry of Finance communication
of 28/11/2019.

Upon commencement of the audit, the auditor receives a data medium or data package.

In line with the focus of auditing, the auditor searches for the relevant tables and then imports
these. The data medium/data package contains tax relevant data and descriptive data to
allow the data to be imported without further clarifications. As soon as the data have been
imported into the analysis software, the auditor carries out various analyses (in part also
automated by means of macros).

1.  Requests data medium/data package
2. Imports from data medium/data package
3. Carries out analysis or runs analysis macros

Figure 1: Auditor
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From the perspective of the business, the scenario described above involves the following
work steps:

¢ An employee initiates the extraction of data or exporting from the production database,
during which process data are potentially (automatically) transformed in the sense of
changing the way the data are organized, the structure of the tables or the structure of
the objects.

¢ Similarly, in the case of compressed or encrypted data, the compression or encryption
must be removed. It is then additionally necessary to create or copy a description in the
form of a machine-analyzable file to accompany the tax relevant data. A file of this type
must be created during the process of provision in a case where the software
manufacturer is unable to foresee which data are to be provided during the audit. It is
possible to provide a static file if the scope and structure of the data are certain
beforehand.
The data are subsequently saved automatically or manually to a portable data
medium/data package.

Productive System

« Extraction : grganFlzatlon
« Transformation ata Formats

* Provision * Links

* Compression

e SAP

* Datev

e Infor

¢ Navision

¢ QOracle Financials
* Varial

e individual software
e others

Auditor

Figure 2: Data carrier cession
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Organization of data during data carrier cession

The German Federal Ministry of Finance communication of 16/07/2001 as a matter of
principle provides audited companies substantial leeway for the technical organization of the
data medium/data package to be transferred.

After the tax authorities of the German federation and federal states have procured analysis
software in common use for auditing (IDEA), the auditors are in a position to read and
process data mechanically (automated or manually). The financial authority does not define
the data fields and contents saved to the data medium/data package during data carrier
cession. It is therefore necessary that parties subject to taxation and/or manufacturers of
software who process tax relevant data decide themselves which data are to be provided
during data carrier cession. Depending on the individual EDP system, software structures,
business structure and size, a variety of data contents may here be sensible and necessary.

In order to minimize queries by auditors regarding the content of data and formats or to
render these unnecessary, a procedure is described here which describes and comments on
the data, data structures and links.

In order to be able to process the various data structures, the party subject to taxation or
his/her advisor makes the tax relevant data available in a largely denormalized form.
Additionally, he/she provides a machine-analyzable description of the data, data formats and
links. The file format for the tax relevant data has been standardized to common default
formats. Both tax relevant data and description data are made available on a common data
medium/in a common data package.

Tax-relevant data

Data package

i

Description file:
Data description and linking

Figure 3: Data organization
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The supported file formats for tax relevant data are:

e VariableLength
e FixedLength

In this way, it is possible for the software systems to use pre-existing export filters or storage
mechanisms.

Internal revenue does not permit any installation of special software in order to decrypt or
uncompress data on its systems. However, during conventional mailing of data media, at
minimum, the encryption of data is required for data protection reasons. The default data
structure therefore, for example, provides for programs for decryption or uncompressing to
be started directly from the data medium without these installing themselves on the internal
revenue system.

The computers of the auditors are equipped with access protection software and where
applicable also with anti-virus software. The functionality of these directly accessed programs
should therefore be clarified by the data provider in advance. Testing whether these routines
can be executed does not form part of this default data structure.

The role of the software manufacturer

In what follows, a “software manufacturer” — from the perspective of the business subject to
taxation — is assumed to refer to a supplier of software or a data processing system,
including programs, or an internal department that makes relevant programs or services
available.

In line with the outlined scenarios for auditing, amongst others, a machine-analyzable
description of data and links needs to be made available during auditing.

The description file is read by a program that, in line with this description, controls the import
function of the analysis program of the tax auditor. No operations are carried out on
databases of the productive systems.

The manufacturer of the programs or procedures by means of which the business subject to
taxation processes tax relevant data (software manufacturer) must in addition to extraction
functionality ensure the formatting or provision of the description functionality.

Default data structure GDPdU/GoBD 9
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XML-based default data structure

Overview

XML stands for “eXtensible Markup Language”. XML only prescribes a generic set of
language elements, so that an individual language needs to be defined based on each
individual instance of application. The in each instance newly formulated language can be
stored in a machine-readable form by means of structure information and element definitions
ina DTD (Document Type Definition). In this way, an XML parser can check whether an XML
document corresponds to the agreed language (validation). A distinction is therefore drawn
between the language description in the DTD and the contents in the XML instance.

Within the DTD itself, no descriptive data are therefore stored for the data carrier cession, but
instead in the XML file called index.xml. The DTD describes the structure of the index.xml
file.

Additional information regarding XML is available at https://www.w3.0rg.

General assumptions or requirements for the DTD

In the DTD, it is assumed that the tax relevant data are organized into files. Per table, exactly
one file is assumed, so that organization according to file and table coincide physically.

The descriptive data for the data carrier cession are saved into a file called index.xml.

The DTD needs to be located in the same directory on the data medium/in the data package
as the index.xml file.

In the event that more than one data medium is provided, the index.xml file must only be
located on the first data medium.

Default data structure GDPdU/GoBD 10



~ caseware

Technical sequence of the import process

The import process is controlled by a component that interprets the index.xml file and
transfers the export tables from the individual data media/data packages to the analysis

software. This component checks the index.xml file for correctness and serves as a table of
contents for the delivered data for the auditor.

GDPdU Interpreter

Analysis
software

Figure 4: Import process

Default data structure GDPdU/GoBD 1
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The XML DTD

<?xml version="1.0" encoding="UTF-8"?>
<l--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one to use alias
elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
<Alias>
<From>Customer</From>
<To>Customerld</To>
</Alias>

1.6 (March-03-2019)
Updated the Map and From/To elements descriptions so they allow
importing an Alphanumeric column as Time column.
This allows defining that an Alphanumeric column contains

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
-

<l-- Start Simple Types -->

<l-- Supplementary Vocabulary -->
<IELEMENT Version (#PCDATA)>
<IELEMENT Location (#PCDATA)>
<IELEMENT Comment (#PCDATA)>
<IELEMENT Length (#PCDATA)>
<IELEMENT References (#PCDATA)>
<IELEMENT From (#PCDATA)>
<I[ELEMENT To (#PCDATA)>

<!-- Sometimes, it is desirable to have a <Media> with
no tables.

Example:
An extension might provide metadata
that describes all tax-relevant data.

This option is turned off by default. -->
<IELEMENT AcceptNoTables (#PCDATA)>

<l-- Use Alias to reference columns with different names in
a ForeignKey element. These Alias elements are optional.

data of type Time and allows you to specify which is the time format used.

Default data structure GDPdU/GoBD
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The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key Orderld
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order references Orderld.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey> -->
<IELEMENT Alias (From, To)>

<I-- Specifying a maximum length for a VariableLength column can
reduce a VariableLength tables' import time. If MaxLength
is not specified then we parse URL to determine the MaxLength
for each column.

* Only applies to VariableLength tables. -->
<I[ELEMENT MaxLength (#PCDATA)>

<l-- Specifies which character (if any) encapsulates a
VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "

* Only applies to VariableLength tables. (Optional) -->
<IELEMENT TextEncapsulator (#PCDATA)>

<l-- Specifies how many digits appear to the right of the decimal symbol.

CAUTION: Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0' (Optional)
-

<IELEMENT Accuracy (#PCDATA)>

<l-- The decimal place is not always stored with numbers. If each number
is supposed to have decimal places use ImpliedAccuracy -->
<IELEMENT ImpliedAccuracy (#PCDATA)>

<l-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->
<IELEMENT Format (#PCDATA)>

<l-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ;'
Specified once per Table. -->
<IELEMENT DecimalSymbol (#PCDATA)>

<l-- Specifies the symbol that groups the digits in large numbers.
Dot is the default DigitGroupingSymbol or ThousandsSeperator. "'
Specified once per Table -->
<IELEMENT DigitGroupingSymbol (#PCDATA)>

<l-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
>
<IELEMENT Command (#PCDATA)>

<l-- Only the file protocol is supported at this time.

Default data structure GDPdU/GoBD
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* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ../Accounts.dat
-

<IELEMENT URL (#PCDATA)>

<l-- Textual description of specified element (Optional) -->
<IELEMENT Description (#PCDATA)>

<l-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<IELEMENT Name (#PCDATA)>

<l-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<IELEMENT Epoch (#PCDATA)>

<l-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ;'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<IELEMENT ColumnDelimiter (#PCDATA)>
<IELEMENT RecordDelimiter (#PCDATA)>

<l-- The number of bytes skipped before reading of URL commences.
Zero is the default when not specified. '0'
-—>

<IELEMENT SkipNumBytes (#PCDATA)>

<l-- End Simple Types -->
<l-- Start Complex Types -->

<l-- Use Extension when you want to add application
specific functionality to the existing standard.

Name - the extension name or identifier.
URL - the supplementary .xml file that corresponds to the
extension.

An application that extends the standard should scan the
Dataset element for the presence of zero or more Extension
elements. The application can use the Name element to identify
the extension.

When choosing a name for your extension, do not choose a common
name. This will reduce undefined results for name conflicts.

It is possible that future extensions will be ratified as
mandatory to meet GDPdU guidelines. -->
<IELEMENT Extension (Name, URL)>

<l-- Self-explanatory -->
<IELEMENT Range (From, (To | Length)?)>
<IELEMENT FixedRange (From, (To | Length))>

<l-- The document element -->
<I[ELEMENT DataSet (Extension*, Version, DataSupplier?, Command*, Media+, Command*)>

<l-- Supported datatypes (mandatory) -->

<IELEMENT AlphaNumeric EMPTY>

<IELEMENT Date (Format?)>

<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<l-- Supported codepages:
Be careful to explicitly define RecordDelimiter when using
a non-default codepage.

Default data structure GDPdU/GoBD
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ANSI is the default codepage when not specified -->
<IELEMENT ANSI EMPTY>
<IELEMENT Macintosh EMPTY>
<I[ELEMENT OEM EMPTY>
<IELEMENT UTF16 EMPTY>
<IELEMENT UTF7 EMPTY>
<IELEMENT UTF8 EMPTY>

<l-- Supported file formats:

FixedLength

VariableLength -->

<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*)>
<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?, TextEncapsulator?, ((VariablePrimaryKey+,
VariableColumn*) | (VariableColumn+)), ForeignKey*)>
<IELEMENT VariableColumn (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>

<l-- Description of the entity supplying the data. (Optional) -->
<IELEMENT DataSupplier (Name, Location, Comment)>

<!I-- The first Media will contain index.xml. Importing will process each media listed -->
<IELEMENT Media (Name, Command*, Table*, Command*, AcceptNoTables?)>

<!I-- Elements common to FixedLength & VariableLength are propagated to Table. -->
<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh | OEM | UTF16 | UTF7 | UTF8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength))>

<l-- ForeignKeys denote joins or relationships between tables.
To successfully join two tables make sure both the PrimaryKey
and the referenced column (ForeignKey) are of the same datatype.
Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur.

see line 35 for information about Alias -->
<IELEMENT ForeignKey (Name+, References, Alias*)>

<l-- Maps AlphaNumeric columns from 'From' to 'To'

ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric ~ -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and because the Time
data type was not defined yet we allow specifying that an Alphanumeric
column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

If the application which interprets the xml and the target application
to import into are able to deal with time data type this column data could
be imported as Time data type

The value of the From element has to be equal with the value of the To
element, in order to not be interpreted as an actual Alphanumeric data mapping
in which the intention is to replace a certain text with a different text at

import time, and be a valid Time format.

The following formats are recognized as valid Time formats:

HH as symbols for hours

MM as symbols for minutes

Default data structure GDPdU/GoBD
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SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if needed.

Examples of valid formats:
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT
-—>

<IELEMENT Map (Description?, From, To)>

<l-- Documentation for table validity. -->
<IELEMENT Validity (Range, Format?)>

<l-- End Complex Types -->

HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,

Figure 5: XML DTD

Default data structure GDPdU/GoBD
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Organization of the default data structure

a XML

= version 1.0
= encoding UTF-3
:| DOCTYPEDataSet

! DataSet
{}version 1.0
| DataSupplier
{} Hame Glaswerk LG
{}Location |SingenDeutschland
{} Comment Datertraegeriberlazzung nach GOPdU vom 14.August 2002, Dr. Grassle, Tel: 07544 934266
Media (2]
{} Hame {} Table

k|l

1 CD MNummer 1 | = Table

> Table
2 CD MNummer 2 | = Table
> Table
> Table
| Table
{}URL hestelungen csyv
{} Hame Bestellungen
{} Description Bestellungen-Bewegungsdaten
| VariableLength
4 VariableColumn (5]

{¥Hame  {} AlphaHumeric {} Date {} Humeric|
1 Artikel-Mr
2 Kunden-Code
3 Bestellddatum Date
{} Format v YMMDD
4 Lieferdstum Date
{} Format v YMMDD
5 Bestelldatum Date

{} Format v YMMDD
_ 6 Frachtkosten
Q= Comment wettere columns...
< ForeignKey (2]
{}Hame {}References
1 Kunden-Code Kunden
. 1 _l 2 Artikel-ID Artikel

Figure 6: Default data structure — organization

The basic element of the default data structure is the DataSet element. This contains the
elements of Extension, Version, DataSupplier, Command and Media.

e Version contains the version number of the data media provision.

e DataSupplier contains details concerning the origin of data.

e The media containers contain details concerning the provided data media and tables
stored on these. Here, for each data medium provided, an individual media entry is

carried out. It is therefore also possible to combine a number of data media within a
DataSet.
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Figure 7: Default data structure — DataSet
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Figure 8: Default data structure — FixedLength
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Figure 9: Default data structure — VariableLength
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Notes regarding XML

Note on operators common in XML.:

Operator Element type may occur

? 0 times or 1 time

* 0 times or as often as desired
+ 1 time or as often as desired

Table 3: Overview of common operators

#PCDATA stands for parsed character data and means that the element is provided for a
text entry.

In the case of enumerations, the possible values are separated by means of vertical lines
(")

XML is case sensitive.

Please do not use any of the following characters in the descriptive fields and/or the table
or column names: " & < >

Instead use names or numbers from the list below:

Character Name Number
" &quot; &#34;
& &amp; &#38;
< &lt; &#60;
> &gt; &#62;

Table 4: List of names and numbers for the characters " & < >

Default data structure GDPdU/GoBD 21
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Description of elements
What follows is a description of the individual ELEMENT declarations.
What generally applies is that the texts stored in the relevant “description” attributes are

displayed to the auditor as commentary. The length of the text in the description attributes
should not exceed 255 characters.

<!IELEMENT Version (#PCDATA)>

Contains the version number of the data media provision. This element has no technical
effect but serves as a description.

Used in container Context-dependent description

DataSet

Table 5: ELEMENT Version

<IELEMENT Location (#PCDATA)>
Describes the location of the data supplier.

Used in container Context-dependent description

DataSupplier

Table 6: ELEMENT Location

<IELEMENT Comment (#PCDATA)>
Comment field for additional information concerning the data supplier.

Used in container Context-dependent description

DataSupplier

Table 7: ELEMENT Comment

<IELEMENT Length (#PCDATA)>
Contains information concerning the length of attributes or datasets.

Used in container Context-dependent description

Range

Table 8: ELEMENT Length

Default data structure GDPdU/GoBD
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<IELEMENT References (#PCDATA)>
Contains information concerning links.

Used in container Context-dependent description

ForeignKey referenced table

Table 9: ELEMENT References

In this regard also see example on page 42.

<IELEMENT From (#PCDATA)>
Contains information concerning the starting value of a value range.

Used in container Context-dependent description

Range Starting value within a value range

Map Redefinition of data and type

Alias Name of the column from current table used
in a foreign key definition

Table 10: ELEMENT From

<IELEMENT To (#PCDATA)>
Contains information concerning the end value of a value range.

Used in container Context-dependent description

Range End value within a value range

Map Redefinition of data and type

Alias The corresponding column name from the
referenced table for a foreign key

Table 11: ELEMENT To

<IELEMENT MaxLength (#PCDATA)>

Contains information concerning the maximum length of an alpha-numeric field in a
VariableLength table.

Used in container Context-dependent description
VariableColumn Maximum length of the field
VariablePrimaryKey Maximum length of the field

Table 12: ELEMENT MaxLength

The specification of MaxLength for the VariableLength file type speeds up the import
process, because otherwise the file would be tested before the import process and the
maximum lengths of fields would be determined.

Default data structure GDPdU/GoBD 23
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<IELEMENT TextEncapsulator (#PCDATA)>

In the case of VariableLength files, it is possible to encapsulate text fields using an
“Encapsulator” character, e.g. in case the field separator occurs in the data.

Standard value: "

Used in container Context-dependent description

VariableLength

Table 13: ELEMENT TextEncapsulator

<IELEMENT Accuracy (#PCDATA)>

Number of decimal places. Be careful with data the accuracy of which is more precise than
specified under Accuracy.

Standard value: 0

Used in container Context-dependent description

Numeric

Table 14: ELEMENT Accuracy

<IELEMENT ImpliedAccuracy (#PCDATA)>
Number of decimal places, even when no decimal places are specified in the source data.

Example:
Source data: “100; 200; 102; 5000; 6587890”
ImpliedAccuracy 3: “0,100; 0,200; 0,102; 5,000; 6587,890”

Used in container Context-dependent description

Numeric

Table 15: ELEMENT ImpliedAccuracy
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<IELEMENT Format (#PCDATA)>
Details concerning format definitions.

Standard value: DD.MM.YYYY

Used in container

Context-dependent description

Date

This is where the mask for the
representation of the date details is stored.

The following specifications for the format
are valid:

e DD for day,
¢ MM for month,
o YY or alternatively YYYY for year.

Example (30 September 2001)

e MM/DD/YY: 09/30/01

e DD.MM.YY: 30.09.01

e MM/DD/YYYY: 09/30/2001
e YYYY-MM-DD: 2001-09-30
e DDMMYY: 300901

e DDMMYYYY: 30092001

Validity

Masking for the date format used (see Date)

Table 16: ELEMENT Format

<IELEMENT DecimalSymbol (#PCDATA)>
Specification concerning the decimal place separator

Standard value: ,

Used in container

Context-dependent description

Table

Table 17: ELEMENT DecimalSymbol

<IELEMENT DigitGroupingSymbol (#PCDATA)>

Defines the separator for thousands.

Standard value: .

Used in container

Context-dependent description

Table

Table 18: ELEMENT DigitGroupingSymbol
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<!IELEMENT Command (#PCDATA)>

Command defines an operating system command. These can be carried out at the following

points:

prior to the overall import process

after the overall import process

prior to an individual data medium being imported
after an individual data medium being imported

Used in container Context-dependent description
DataSet Command for the overall process
Media Command for an individual data medium

Table 19: ELEMENT Command

In this regard also see example on page 45.

<IELEMENT URL (#PCDATA)>
This element contains the physical file name of the file provided.

In this version of the default data structure, relative URLs are supported exclusively. The
path to the index.xml file serves as the base directory.

Examples of invalid entries:
http://www.somewhere.com/data/Accounts.csv
ftp://ftp.somewhere.com/data/Accounts.csv

Examples of valid entries:
Accounts.dat
data/Accounts.dat
data/january/Accounts.dat
../Accounts.dat

Used in container Context-dependent description

Table

Table 20: ELEMENT URL
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<IELEMENT Description (#PCDATA)>
Description field

Used in container

Context-dependent description

FixedColumn

Description field for columns in FixedLength
files

FixedPrimaryKey

Description field for keys in FixedLength
files

VariableColumn

Description field for columns in
VariableLength files

VariablePrimaryKey Description field for keys in VariableLength
files

Table Description field for tables

Map Description field for redefinition of data

Table 21: ELEMENT Description

<IELEMENT Name (#PCDATA)>
Description field

Standard value: Specification from the URL element

Used in container

Context-dependent description

FixedColumn

Column name in FixedLength files

FixedPrimaryKey Key name in FixedLength files
VariableColumn Column name in VariableLength files
VariablePrimaryKey Key name in VariableLength files

DataSupplier

Name of the data supplier (company
name, ...)

Media Data media name
URL Physical table name
ForeignKey Name of the foreign key

Table 22: ELEMENT Name
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<IELEMENT Epoch (#PCDATA)>

For dates with a two-digit year format, it is possible to specify a standard placeholder that
separates 19xx from 20xx. This value is pre-populated with 30.

In some files, the date 25 November 55 can mean either 1955 or 2055. Using Epoch, it is
specified up to which two-digit value the year is to be interpreted as referring to the next
century. For instance, if the century separation value field contains the value 50, all year
indications from 0 to 49 will be interpreted as the years 2000 to 2049, and the year
indications 50 to 99 as 1950 to 1999.

Standard value: 30

Used in container Context-dependent description

Table

Table 23: ELEMENT Epoch

<IELEMENT ColumnDelimiter(#PCDATA)>
Defines the separator for data fields.

Standard value: &#59; (semicolon ;")

Used in container Context-dependent description

VariableLength Data field separator

Table 24: ELEMENT ColumnDelimiter

Example of conventional separators:

Separator XML notation
Comma “,” &#44;
Semicolon “;” &#59;

Tab &#9;

Table 25: ELEMENT ColumnDelimiter — list of common separators
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<IELEMENT RecordDelimiter (#PCDATA)>

Defines separators for datasets.

Standard value: &#13;&#10; (CRLF)

Used in container

Context-dependent description

FixedLength

Dataset separator

VariableLength

Dataset separator

Table 26: ELEMENT RecordDelimiter

Example of conventional separators:

Separator XML notation
CR Carriage Return &#13;

CRLF &#13;&#10;
LF Linefeed &#10;

Table 27: ELEMENT RecordDelimiter — list of common separators

<IELEMENT SkipNumBytes (#PCDATA)>

If a file contains undesirable data at the beginning, e.g. file header, it needs to be specified
here how many bytes are to be skipped and not read.

Standard value: 0

Used in container

Context-dependent description

Table

Table 28: ELEMENT SkipNumBytes

<IELEMENT Range (From, (To | Length)?)>

Defines a range or a starting value.

Starting value means: if no To or Length is specified, this range only defines a starting value

(e.g. a dataset position).

Used in container

Context-dependent description

Table

Start dataset

Validity

Validity range

Table 29: ELEMENT Range
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<IELEMENT FixedRange (From, (To | Length))>
Defines a range specifying From and To or From and Length.

Used in container Context-dependent description
FixedColumn Field position in FixedLength files
FixedPrimaryKey Key position in FixedLength files

Table 30: ELEMENT FixedRange

<IELEMENT DataSet (Extension*, Version, DataSupplier?, Command*, Media+
Command*)>

The DataSet is the upper element (document element) in the hierarchy of the XML
document. The element DataSet is the medium for the extension, version, data origin,
preceding and subsequent processes and the media containing the tables.

<IELEMENT AlphaNumeric EMPTY>
Defines the data type as alpha-numeric.

3

Used in container Context-dependent description
FixedColumn Type of field in FixedLength file
FixedPrimaryKey Type of key in FixedLength file
VariableColumn Type of field in VariableLength files
VariablePrimaryKey Type of key in VariableLength files

Table 31: ELEMENT AlphaNumeric

<IELEMENT Date (Format?)>
Defines the data type as date.

Used in container Context-dependent description
FixedColumn Type of field in FixedLength file
FixedPrimaryKey Type of key in FixedLength file
VariableColumn Type of field in VariableLength files
VariablePrimaryKey Type of key in VariableLength files

Table 32: ELEMENT Date
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<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
Defines the data type as numeric.

Used in container Context-dependent description
FixedColumn Type of field in FixedLength file
FixedPrimaryKey Type of key in FixedLength file
VariableColumn Type of field in VariableLength files
VariablePrimaryKey Type of key in VariableLength files

Table 33: ELEMENT Numeric

<IELEMENT ANSI EMPTY>
Specifies the use of the ANSI code page.

<IELEMENT Macintosh EMPTY>
Specifies the use of the Macintosh code page.

<IELEMENT OEM EMPTY>
Specifies the use of the IBM-PC-ASCII code page.

<IELEMENT UTF16 EMPTY>
Specifies the use of the UTF16 code page.

<IELEMENT UTF7 EMPTY>
Specifies the use of the UTF7 code page.
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<!ELEMENT UTF8 EMPTY>

Specifies the use of the UTF8 code page.

Standard value: ANSI

Platform

Character set

Unix computers

7-bit ASCII character set (7-bit ISO code,
US variant), only characters with ASCII
code below 128, in other words letters,
numbers and special characters (full-stop,
comma, etc.) without country-specific
special characters (umlauts, etc.) and
without graphics characters. Line break is
LF (Line Feed), character 10.

PC under DOS

8-bit “IBM PC ASCII” character set that in
terms of the lower 127 characters
corresponds to 7-bit ASCIl and from
character 128 contains country-specific
special characters and (semi-)graphics
characters. Line break is the sequence CR
and LF, representing characters 12 and 10
(Carriage Return, Line Feed).

PC under Windows

8-bit ANSI character set, which up to 127
corresponds to ASCII and above 127
contains country-specific special characters
that do not correspond to those of IBM PC
ASCII. Line breaks, as under DOS, the
sequence CR, LF. (Special applications are
also able to use a 16-bit code, Unicode.)

Apple Mac

Mac-specific “Mac-ASCII” 8-bit character
set, which up to 127 corresponds to ASCII
and above 127 contains country-specific
special characters. Line break is CR.

Table 34: ELEMENT UTF8

The selection of code page does not set a default for the RecordDelimiter. You will always
have to specify the RecordDelimiter explicitly if the standard value (CRLF) is not suitable.
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<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+,
FixedColumn*) | (FixedColumn+)), ForeignKey*)>

Defines a FixedLength type file.

Used in container Context-dependent description

Table

Table 35: ELEMENT FixedLength

<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric |
Date), Map*, FixedRange)>
Defines a column (=column) in a FixedLength type file.

Used in container Context-dependent description

FixedLength

Table 36: ELEMENT FixedColumn

<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric |
Date), Map*, Range)>
Defines a key field (=key) in a FixedLength type file.

Used in container Context-dependent description

FixedLength

Table 37: ELEMENT FixedPrimaryKey

In this regard also see example on page 42.

<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+))?, ForeignKey*)>

Defines a VariableLength type file.

Used in container Context-dependent description

Table

Table 38: ELEMENT VariableLength

The fields (VariableColumn, VariablePrimaryKey) must be defined in the sequence in which
they are delivered in the file.
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<IELEMENT VariableColumn (Name, Description?, (Numeric | AlphaNumeric,

MaxLength ? | Date), Map*)>

Defines a column (=column) in a VariableLength type file.

Used in container

Context-dependent description

VariableLength

Table 39: ELEMENT VariableColumn

The fields (VariableColumn, VariablePrimaryKey) must be defined in the sequence in which

they are delivered in the file.

<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric |
AlphaNumeric, MaxLength ? | Date), Map*)>

Defines a key field (=key) in a VariableLength type file.

Used in container

Context-dependent description

VariableLength

Table 40: ELEMENT VariablePrimaryKey

The fields (VariableColumn, VariablePrimaryKey) must be defined in the sequence in which

they are delivered in the file.

Concerning links also see example on page 42.

<IELEMENT DataSupplier (Name, Location, Comment)>

Contains details concerning the data supplier.

Used in container

Context-dependent description

DataSet

supplier (company, ...)

Table 41: ELEMENT DataSupplier

<IELEMENT Media (Name, Command*, Table+, Command*, AcceptNoTables?)>

Defines the content of a data medium.

Used in container

Context-dependent description

DataSet

data media transfer

Table 42: ELEMENT Media
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<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh |
OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol, DigitGroupingSymbol)?,
SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength)?)>
Defines a table.

Used in container Context-dependent description

Media table

Table 43: ELEMENT Table

<IELEMENT ForeignKey (Name+, References, Alias*)>
Defines a column as a foreign key.

The column referenced by name must be defined as a FixedPrimaryKey/FixedColumn or
VariablePrimaryKey/VariableColumn in the same table.

References is the name of the referenced table and Alias is used if the referenced column
has a different name in the referenced table, see Alias element definition for more info.

Used in container Context-dependent description
FixedLength Field in FixedLength file, referenced table
VariableLength Field in VariableLength file, referenced table

Table 44: ELEMENT ForeignKey

In this regard also see example on page 42.

<IELEMENT Map (Description?, From, To)>
Redefinitions at the data level can be carried out by means of the Map element.

Example:
From (original data) To (target data)
1 true
0 false
Hr Herr (Mister)
Fr Frau (Mrs/Miss)
01 married
02 single
03 tax category 3

Table 45: ELEMENT Map — redefinitions
Used in container Context-dependent description
FixedColumn Field in FixedLength file
FixedPrimaryKey Key in FixedLength file
VariableColumn Field in VariableLength files
VariablePrimaryKey Key in VariableLength files

Table 46: ELEMENT Map

Map may only be used for alpha-numeric fields.
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You should avoid delivering coded errors as part of the data carrier cession and instead
convert all codes into textual descriptions. In the event that this conversion is not already
carried out by the export program, Map represents a possibility for converting codes using
data description.

Map also allows you to specify that an alphanumeric column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

If the application which interprets the xml and the target application to import into are able to
deal with Time data type, this column data could be imported as Time data type.

The value of the From element has to be equal to the value of the To element, in order to not
be interpreted as an actual Alphanumeric data mapping in which the intention is to replace a
certain text with a different text at import time, and be a valid Time format.

The following formats are recognized as valid Time formats:
HH as symbols for hours
MM as symbols for minutes
SS as symbols for seconds
TT as symbols for AM/PM
SS and TT are optional when defining the format.
A time format separator can also be supplied if needed.

Examples of valid formats:
HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT

<IELEMENT Validity (Range, Format?)>
Defines the validity period for the data.

Used in container Context-dependent description

Table Validity period

Table 47: ELEMENT Validity

<IELEMENT AcceptNoTables (#PCDATA)>
Defines that a <Media> has no tables.

Used in container Context-dependent description

Media Media has no tables

Table 48: ELEMENT AcceptNoTable

Sometimes, it is desirable to have a <Media> with no tables.
Example:
An extension might provide metadata that describes all tax-relevant data.
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<IELEMENT Alias (From, To)>
Defines the corresponding column names pair when defining a foreign key reference.

Used in container Context-dependent description
ForeignKey Specify for a column name the name of the
column it references in the referenced table

Table 49: ELEMENT Alias

Use Alias to reference columns with different names in a ForeignKey element. These Alias
elements are optional.
The following rules apply to the Alias element:

e One or more Alias elements can be used per ForeignKey.
o Alias elements can appear in any order.

Example:
Table Orders has a primary key Orderld
Table Accounts has a foreign key Order.

You can use the Alias element to specify that Order references Orderld.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey>

Default data structure GDPdU/GoBD

37



caseware

<IELEMENT Extension (Name, URL)>
Allows you to add application specific functionality to the existing standard.

Used in container Context-dependent description

DataSet

Table 50: ELEMENT Extension

Use Extension when you want to add application specific functionality to the existing
standard.

Name — the extension name or identifier.
URL — the supplementary .xml file that corresponds to the extension.

An application that extends the standard should scan the Dataset element for the presence
of zero or more Extension elements. The application can use the Name element to identify
the extension.

When choosing a name for your extension, do not choose a common name. This will reduce
undefined results for name conflicts.

It is possible that future extensions will be ratified as mandatory to meet GDPdU/GoBD
guidelines.
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Example 1 of an index.xml file

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.0</Version>
<DataSupplier>
<Name>Glaswerk AG</Name>
<Location>Singen/Deutschland</Location>
<Comment>Datentraegeriberlassung nach GDPdU vom 14.August 2002, Dr. Gréassle, Tel: 07544
934266</Comment>
</DataSupplier>
<Media>
<Name>CD Nummer 1</Name>
<Table>
<URL>Account.csv</URL>
<Name>Account</Name>
<Description>Accounts Receivables</Description>
<I-- Diese Tabelle gilt von 1.Januar 2000- 31.Dezember 2002 -->
<Validity>
<Range>
<From>20000101</From>
<T0>20021231</To>
</Range>
<Format>YYYYMMDD</Format>
</Validity>
<I-- Spezifiziert den Dezimaltrenner -->
<DecimalSymbol>.</DecimalSymbol>
<I-- Spezifiziert den Tausender-Separator -->
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariableLength>
<!-- ein zusammengesetzter Primaerschlissel -->
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariablePrimaryKey>
<Name>ld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Account Description</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Balance</Name>
<Numeric/>
</VariableColumn>
<VariableColumn>
<Name>Old Balance</Name>
<Numeric/>
</VariableColumn>
</VariableLength>
</Table>
<Table>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>
</Media>
<Media>
<Name>CD Nummer 2</Name>
<Table>
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<URL>Sales.csv</URL>
<Range>
<From>56</From>
</Range>
<FixedLength>
<FixedPrimaryKey>
<Name>Salesld</Name>
<AlphaNumeric/>
<FixedRange>
<!-- Position des Feldes: -->
<From>1</From>
<To>10</To>
</FixedRange>
</FixedPrimaryKey>
<FixedColumn>
<Name>Regionld</Name>
<AlphaNumeric/>
<FixedRange>
<From>11</From>
<Length>10</Length>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>Ild</Name>
<AlphaNumeric/>
<FixedRange>
<From>21</From>
<To>30</To>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>SalesComplete</Name>
<AlphaNumeric/>
<I-- Redefinition des Wertes "1" nach "True" und "0" nach "False" -->
<Map>
<From>1</From>
<To>True</To>
</Map>
<Map>
<From>0</From>
<To>False</To>
</Map>
<FixedRange>
<From>31</From>
<To>32</To>
</FixedRange>
</FixedColumn>
<!-- ein zusammengesetzter Fremdschluessel der den Primaerschluessel in Tabelle Account
referenziert -->
<ForeignKey>
<Name>Regionld</Name>
<Name>ld</Name>
<References>Account</References>
</ForeignKey>
</FixedLength>
</Table>
<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
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</VariableLength>
</Table>
<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<I-- weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<!-- weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-ID</Name>
<References>Artikel</References>
</ForeignKey>
</VariableLength>
</Table>
</Media>
</DataSet>

<Description>Bestellungen-Bewegungsdaten</Description>

Figure 10: Example 1 — index.xml file
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Example 2 regarding links

It may make sense in terms of data carrier cession not to deliver transaction data and master
data in one broad table, but instead to save these into separate tables:

Example:

Kunden

*

KUNDEN_CODE
FIRMA
[KONTAKTPERSON
POSITION
STRARE

Artikel

ARTIKELNAME
LEEFERANTEN_NR
KATEGORIE_NR

ORT

Bestellungen

LEEFEREINHET

REGION
PLZ
LAND
TELEFON
[TELEFAX

EINZELPREIS

*

ARTIKELLNR

¢| KUNDEN_CODE

[BESTELLDATUM
LIEFERDATUM
FRACHTKOSTEN
[EMPFANGER
STRARE

omT
[BESTIMMUNGSLAND
[EINZELPREIS
ANZAHL

RABATT

LAGERBESTAND
BESTELLTEEINHEITEN
MINDESTBESTAND
AUSLAUFARTIKEL

*
ARTKEL_NR

Figure 11: Example 2 — tables with transaction data and master data

The primary keys are described in the master data:

<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>

<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<I-- weitere columns... -->
</VariableLength>
</Table>

<Description>Kunden-Stammdaten</Description>

<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>

<Description>Artikel-Stammdaten</Description>

<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>
</Table>

Figure 12: Example 2 — master data
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The transaction data describe the links to the master data via the specification of the foreign

key relationship:

<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>

<AlphaNumeric/>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Numeric/>
</VariableColumn>
<I-- weitere columns... -->
<ForeignKey>

</ForeignKey>
<ForeignKey>
<Name>Artikel-Nr</Name>

</ForeignKey>
</VariableLength>
</Table>

<Description>Bestellungen-Bewegungsdaten</Description>

<Name>Kunden-Code</Name>

<Name>Bestelldatum</Name>

<Format>YYYYMMDD</Format>

<Name>Lieferdatum</Name>

<Format>YYYYMMDD</Format>

<Name>Bestelldatum</Name>

<Format>YYYYMMDD</Format>

<Name>Frachtkosten</Name>

<Name>Kunden-Code</Name>
<References>Kunden</References>

<References>Artikel</References>

Figure 13: Example 2 — transaction data
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Note:

Although the description of a VariablePrimaryKey fully describes the column, the ForeignKey
does not define a new column. The column used in the ForeignKey must already have been

defined as a VariableColumn or FixedColumn in advance.

<ForeignKey>
<Name>FIRM</Name>
<Name>DDKZ</Name>
<Name>KKKZ</Name>
<Name>UKTO</Name>
<Name>BUJM</Name>
<References>FPCPDPU</References>
<Alias>
<From>UKTO</From>
<To>CKTO</To>
</Alias>
<Alias>
<From>BUJM</From>
<To>GAJM</To>
</Alias>
</ForeignKey>

Figure 14: Example 2 — sample of foreign key with multiple aliases
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Example 3 of an index.xml file (compressed data)

index.xml
<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.2</Version>
<DataSupplier>
<Name>Audicon GmbH</Name>
<Location>Germany</Location>
<Comment>A compressed sample DataSet</Comment>
</DataSupplier>
<Command>uncompress.bat</Command>
<Media>
<Name>Disk 1</Name>
<Table>
<URL>dummy.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>dummy</Name>
<Numeric/>
</VariablePrimaryKey>
</VariableLength>
</Table>
</Media>
</DataSet>

Figure 15: Example 3 — index.xml file

uncompress.bat
rem
rem uncompress.bat
rem expandiert gdpdu.zip in das windows-temp-verzeichnis, unterverzeichnis gdpdu
rem
mkdir %temp%\gdpdu
pkunzip gdpdu.zip %temp%\gdpdu

Figure 16: Example 3 — uncompress.bat file

%temp% is an operating system environment variable that represents the path to the
temporary directory.

The file gdpdu.zip contains the compressed data media provision (including the index.xml file
and the gdpdu-01-08-2002.dtd file). After decompression the auditor therefore opens the new
data provision in the directory % TEMP%\gdpdu.

Note:

The <Version> specification does not relate to the version of the default data structure but
the version of the data carrier cession.
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Example 4 of an index.xml file (Time data type)

index.xml

<?xml version="1.0" encoding="utf-8" standalone="no"?>
<!DOCTYPE DataSet SYSTEM "gdpdu-01-03-2019.dtd">
<DataSet>
<Version>1.0.00</Version>
<DataSupplier>
<Name />
<Location />
<Comment>SmartExporter</Comment>
</DataSupplier>
<Media>
<Name>Disk1</Name>
<Table>
<URL>20181120175609 _BKPF.csv</URL>
<Name>BKPF</Name>
<Description>
</Description>
<UTF8 />
<DecimalSymbol>.</DecimalSymbol>
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariablelLength>
<ColumnDelimiter> </ColumnDelimiter>
<TextEncapsulator />
<VariableColumn>
<Name>BUKRS</Name>
<Description>Company Code</Description>
<AlphaNumeric />
<MaxLength>4</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BELNR</Name>
<Description>Accounting Document Number</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BLDAT</Name>
<Description>Document Date in Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>BUDAT</Name>
<Description>Posting Date in the Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>CPUTM</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
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<From>HH :MM</From>
<To>HH:MM</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM1</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HH:MMTT</From>
<TOo>HH:MMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM2</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SSTT</From>
<To>HH:MM:SSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM3</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
<From>HHMM< /From>
<To>HHMM< /To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM4< /Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HHMMTT</From>
<To>HHMMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM5</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM6</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
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<From>HHMMSSTT</From>
<To>HHMMSSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM7</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SS</From>
<To>HH:MM:SS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM8</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>

<Map>
<From>HHMMSS</From>
<TO>HHMMSS</To>
</Map>
</VariableColumn>
</VariableLength>
</Table>
</Media>
</DataSet>

Figure 17: Example 4 — index.xml file with Time data type
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Frequently asked questions

Do we need to deliver data in XML format?
No. Only the description of the data (the index.xml file) is in XML format. The reference
data are in FixedLength or VariableLength format.

Can your system handle data in DOS/Unix/Mac formats (line breaks)?
Yes, because the line breaks can be specified explicitly.

How do negative figures need to be indicated (in front of/behind the figure, space
character between preceding character and digit permissible)?

Negative figures must be preceded or followed by a minus sign without a space character
(e.g. “-1782,90” or “1782,90-").

When a transferred file is too large for a specific data medium, may it then be split
across a number of data media?

This default data structure does not provide for the splitting up of a file. However, in an
instance like this, you may compress data or select a data medium with a higher capacity
(e.g. DVD).

Which XML parser do you use?
We use Xerces (https://xerces.apache.org/xerces-c/).

Is it an error when the ForeignKey references a table that is not contained in the
DataSet, or would the ForeignKey then be ignored?

The description of the links must match the delivered data. Otherwise, your data carrier
cession will not be consistent. The import process will indicate this inconsistency to the
auditor.

What happens when the index.xml file describes a table that is, however,
subsequently not present?

The description of the files must match the delivered data. Otherwise, your data carrier
cession will not be consistent. The import process will indicate this inconsistency to the
auditor.
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¢ Are commands compulsory? Do you offer environment variables for commands?
Commands are not compulsory. When a .BAT or .CMD file is accessed, the conventional
operating system environment variables are available. The import process itself does not
set any environment variables.

¢ How can it finally be checked whether the data of the data medium/data package
can be imported by your system?
The safe method of testing is importing with IDEA for GDPdU/GoBD (IDEA + SmartX).
SmartV will help you to validate the index.xml file and the data to be imported regarding
their conformity with the default data structure.

A simple option for testing the XML file for its syntactic correctness is to open it with an
XML-capable browser.

¢ Since | am not familiar with XML standards, | am not sure how to construct the files
index.xml and gdpdu.dtd concretely. | have sent you a VariableLength file. Would
you be able to create the corresponding XML or DTD file for me?
You should acquire some basic XML knowledge. You do not have to and may not modify
the DTD file.
The description of the data (in the index.xml file) should always be carried out from the
point that has the data ownership, in other words the software manufacturer or the
business subject to taxation.
Audicon offers assistance in verifying the compliance of data carrier cession with the
default data structure and in the construction of the index.xml file (see
https://www.caseware.net/consulting/dienstleistungspakete/ — in German).

¢ In some press releases, apart from VariableLength and FixedLength file formats,
various others are mentioned. Which formats apply to data carrier cessions?
The file formats referred to in some articles relate to the original import options of the
software IDEA.
The default data structure is, however, product independent and in its current version
only supports the two generally applicable formats of VariableLength and FixedLength.

¢ Must the gdpdu-01-03-2019.dtd file also be written to the data medium?
Yes. A data medium serving data carrier cession purposes must contain the gdpdu-01-
03-2019.dtd file, the index.xml file and all reference data (e.g. T1.CSV, T2.CSV, T3.CSV,
T4.ASC).
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¢ In a VariableLength file, the field names are stored in the first dataset. How is it
possible to peruse the first set?
Use the Range specification in the Table element:

<Table>
<Range>
<From>2</From>
</Range>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>

Figure 188: Range specification

¢ By specifying a character set, e.g. UTF7 or Macintosh, is the specification of the
line delimiter overridden automatically?
No. Only by explicitly specifying the line delimiter (RecordDelimiter) is the standard value
(CRLF) overridden.
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Synopsis of default data structure version 1.0 and version 1.1

Renaming is indicated in blue and new or deleted elements in red.

Version 1.0 of 10 May 2002 (6/6/2002)

Version 1.1 of 1 August 2002

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

1.0 (May-10-2002)

-—>

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

1.1 (August-01-2002)

-——>

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->

<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

Version
Location

(#PCDATA) >
(#PCDATA) >
Comment (#PCDATA) >
Length (#PCDATA) >
References (#PCDATA) >
From (#PCDATA)>

<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT
<!ELEMENT

(#PCDATA) >

(#PCDATA) >
(#PCDATA) >
Length (#PCDATA)>
References (#PCDATA) >
From (#PCDATA)>

Version
Location
Comment

To (#PCDATA) >

<!-- Specifies which character
CSV text column -->

(if any) encapsulates a

<!ELEMENT TextEncapsulator (#PCDATA)>

<!-- Specifies how many digits appear to the right of
the decimal symbol. -->

To (#PCDATA) >

<!-- Specifying a maximum length for a VariableLength column
can reduce a VariableLength tables' import time.

If MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->

<!'ELEMENT MaxLength (#PCDATA)>

<!-- Specifies which character (if any)
VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

encapsulates a

* Only applies to Variablelength tables. (Optional) -
>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.
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Version 1.0 of 10 May 2002 (6/6/2002)

Version 1.1 of 1 August 2002

CAUTION:
Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an

accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.
Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA)> <!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with <!-- The decimal place is not always stored with numbers. If
numbers. If each number is supposed to have decimal each number is supposed to have decimal places use
places use ImpliedAccuracy --> ImpliedAccuracy -->
<!ELEMENT ImpliedAccuracy (#PCDATA)> <!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- The first line in CSV URL contains column headers.
A value of False is interpreted if the element is
missing. Any columns specified in the XML file take
precedence over the file. This lets you override some
columns in the file and leave the others as they are.
-=>
<!ELEMENT NamesFirstRow EMPTY>
<!-- Enables you to change how gdpdu displays dates. <!-- Enables you to change how gdpdu displays dates.
The default is implementation dependant. --> DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)> <!ELEMENT Format (#PCDATA)>
<!-- Specifies the symbol that indicates decimal values. | <!-- Specifies the symbol that indicates decimal values.
The default is implementation dependant. Comma is the default DecimalSymbol. ','
Specified once per Table. --> Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) > <!ELEMENT DecimalSymbol (#PCDATA) >
<!-- Specifies the symbol that groups the digits in <!-- Specifies the symbol that groups the digits in large
large numbers. numbers. Dot is the default DigitGroupingSymbol or
The default is implementation dependant. ThousandsSeperator. '.'
Specified once per Table --> Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)> <!ELEMENT DigitGroupingSymbol (#PCDATA) >
<!-- Command(s) are executed in the following manner <!-- Command(s) are executed in the following manner
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Version 1.1 of 1 August 2002

* before the import process
* after the import process
* pbefore a Media is imported

* after a Media is imported
-—>

<!ELEMENT Command (#PCDATA) >
The root path is the path of Media

The following are all invalid
* http://www.somewhere.com/data/Accounts.csv

* ftp://ftp.somewhere.com/data/Accounts.csv
*

The following is wvalid.
* file://Accounts.csv

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element -->
<!ELEMENT Description (#PCDATA) >

<!-- The logical names of specified element -->

<!ELEMENT Name (#PCDATA) >

<!-- Y2K Window Any year before Epoch is 2000+
Default value 50. -->

<!-- Only the file protocol is supported at this time.

* before the import process
* after the import process
* before a Media is imported

* after a Media is imported
-—>

<!ELEMENT Command (#PCDATA) >

<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all
invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element (Optional) -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical name of specified element.
Sometimes referred to business name.
If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA) >
<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
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Version 1.0 of 10 May 2002 (6/6/2002)

Version 1.1 of 1 August 2002

<!ELEMENT Epoch (#PCDATA)>
<!-- Specifies the symbol that seperates CSV columns or
ASCITIFixedLength records. -->

<!ELEMENT Delimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences. -->

<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->

<!-- Start Complex Types -->

<!-- Self-explanetory -->

<!ELEMENT Range (From, (To | Length)?)>

<!-- The document element -->

<!ELEMENT DataSet (Version, DataSupplier?, Command¥*,
Media+, Command*) >

<!-- Supported datatypes

AlphaNumeric is the default datatype when a
datatype is not defined. -->
<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?, Epoch?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!ELEMENT Epoch (#PCDATA)>

<!-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!'ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences. Zero is the default when not specified. '0' -->
<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->

<!-- Start Complex Types -->

<!-- Self-explanatory -->

<!ELEMENT Range (From, (To | Length)?)>

<!'ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->

<!ELEMENT DataSet (Version, DataSupplier?, Command*, Media+,
Command*) >

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:

Be careful to explicitly define RecordDelimiter when using a
non-default codepage.

ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>

<!ELEMENT Macintosh EMPTY>

<!ELEMENT OEM EMPTY>

<!'ELEMENT UTF16 EMPTY>

<!'ELEMENT UTF7 EMPTY>

<!ELEMENT UTF8 EMPTY>
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Version 1.1 of 1 August 2002

<!-- Supported file formats -->

<!ELEMENT ASCIIFixedLength ((Length | Delimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedPrimaryKey*,
FixedColumn+) ), ForeignKey¥*)>

<!ELEMENT FixedColumn (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric
| AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT CSV (NamesFirstRow?, Delimiter?,
TextEncapsulator?, ((PrimaryKey+, Column*) |
(PrimaryKey*, Column+))?, ForeignKey¥*)>

<!ELEMENT Column (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!ELEMENT PrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment) >

<!-- The first Media will contain index.xml. Importing

will process each media listed -->

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to ASCCIIFIXEDLENGTH & CSV are
propagated to Table.

CSV is the default format if none is specified. -->

<!ELEMENT Table
(DecimalSymbol,
Range?, (CSV |

(URL, Name?,
DigitGroupingSymbol) ?,
ASCIIFixedLength)?)>

Description?, Validity?,
SkipNumBytes?,

<!-- ForeignKeys denote joins and relationships between
tables.

Not specifying ForeignKeys prevent joins from
occurring. -->

<!-- Supported file formats: FixedLength, VariablelLength -->
<!ELEMENT FixedLength ((Length | RecordDelimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*) >

<!ELEMENT FixedColumn (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT FixedPrimaryKey (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ), ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map¥*)>
<!ELEMENT VariablePrimaryKey (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>

(Numeric |

(Numeric |

(Numeric |

(Numeric |

<!-- Description of the entity supplying the data. (Optional)
-—>
<!ELEMENT DataSupplier Comment) >

(Name, Location,

<!-- The first Media will contain index.xml. Importing will
process each media listed -->
<!ELEMENT Media (Name, Command¥*,

Table+, Command*) >

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?, (ANSI |
Macintosh | OEM | UTF1l6 | UTF7 | UTF8)?, (DecimalSymbol,
DigitGroupingSymbol) ?, SkipNumBytes?, Range?, Epoch?,
(VariableLength | FixedLength))>

<!-- ForeignKeys denote joins or relationships between
tables. To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of the
same datatype.

Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur. -->
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Version 1.1 of 1 August 2002

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps data from 'From' to 'To’
ie. From To
True 1
True -1
False 0

A map is basically an associative container.
Take caution that 'From' is of the same type
as the column datatype.

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types —-->

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

-=>

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Table 51: Comparison of default data structure version 1.0 and 1.1
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Synopsis of default data structure version 1.1 and version 1.6

Renaming is indicated in blue and new or deleted elements in red.

Version 1.1 of 1 August 2002

Version 1.6 of 1 March 2019

<?xml version="1.0" encoding="UTF-8"7?>
<!--Versions available:

1.1 (August-01-2002)

-—>

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one
to use alias elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
<Alias>
<From>Customer</From>
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Version 1.6 of 1 March 2019

<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA) >
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<To>CustomerId</To>
</Alias>

1.6 (March-03-2019)

Updated the Map and From/To elements descriptions so
they allow importing an Alphanumeric column as Time
column.

This allows defining that an Alphanumeric column
contains data of type Time and allows you to specify which
is the time format used.

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
-—>
<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA) >
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<!-- Sometimes, it is desirable to have a <Media> with no
tables.

Example:
An extension might provide metadata that describes all
tax-relevant data.

This option is turned off by default. -->
<!'ELEMENT AcceptNoTables (#PCDATA)>
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Version 1.6 of 1 March 2019

<!-- Specifying a maximum length for a VariableLength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariableLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariablelLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

<!-- Use Alias to reference columns with different names
in a ForeignKey element. These Alias elements are
optional.

The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key OrderId
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order
references OrderId.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>0Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
</ForeignKey> -->
<!'ELEMENT Alias (From, To)>

<!-- Specifying a maximum length for a VariablelLength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "
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* Only applies to VariableLength tables. (Optional)
-—>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA) >
<!-- Enables you to change how GDPdU displays dates.

DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ','
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) >
<!-- Specifies the symbol that groups the digits in large

numbers.

* Only applies to VariablelLength tables. (Optional)
-—>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)
—-—>
<!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA)>

<!-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->

<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.

Comma is the default DecimalSymbol. ','

Specified once per Table. -->

<!ELEMENT DecimalSymbol (#PCDATA)>

<!-- Specifies the symbol that groups the digits in large

numbers.
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Dot 1is the default DigitGroupingSymbol or

ThousandsSeperator. '.'

Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)>
<!-- Command(s) are executed in the following manner

* before the import process

* after the import process

* before a Media is imported

* after a Media is imported
-—>
<!ELEMENT

Command (#PCDATA) >

<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed.
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>

<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA)>
<!-- The logical name of specified element.

Dot is the default DigitGroupingSymbol or
ThousandsSeperator. '.'
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA) >
<!-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-——>
<!ELEMENT

Command (#PCDATA) >

<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed. The following are
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ../Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>

<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA) >
<!-- The logical name of specified element.
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Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA)>

<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<!ELEMENT Epoch (#PCDATA)>

<!-- Element (s) that separate columns or records.
Semicolon 1s the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter.
-——>
<!ELEMENT ColumnDelimiter (#PCDATA)>

<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences.
Zero is the default when not specified. '0'
-—>
<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->
<!-- Start Complex Types -->

Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA)>

<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<!ELEMENT Epoch (#PCDATA)>

<!-- Element (s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter.
-——>
<!ELEMENT ColumnDelimiter (#PCDATA)>

<!ELEMENT RecordDelimiter (#PCDATA) >

<!-- The number of bytes skipped before reading of URL
commences.
Zero is the default when not specified. '0'
-——>
<!ELEMENT SkipNumBytes (#PCDATA) >

<!-- End Simple Types -->
<!-- Start Complex Types -->
<!-- Use Extension when you want to add application

specific functionality to the existing standard.

Name - the extension name or identifier.

URL - the supplementary .xml file that corresponds
to the extension.

An application that extends the standard should scan
the Dataset element for the presence of zero or more
Extension elements. The application can use the Name
element to identify the extension.

Default data structure GDPdU/GoBD

63




Version 1.1 of 1 August 2002

Version 1.6 of 1 March 2019

<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?, Command*,
Media+, Command*) >

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTFl6 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariablelLength -->

When choosing a name for your extension, do not
choose a common name. This will reduce undefined results
for name conflicts.

It is possible that future extensions will be
ratified as mandatory to meet GDPdU guidelines. -->
<!'ELEMENT Extension (Name, URL)>

<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Extension*, Version, DataSupplier?,
Command*, Media+, Command¥*)>

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTFl16 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariableLength -->

Default data structure GDPdU/GoBD

64




Version 1.1 of 1 August 2002

Version 1.6 of 1 March 2019

<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn¥*) |
ForeignKey*) >

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >

<!ELEMENT FixedPrimaryKey
AlphaNumeric | Date), Map*,

(Name, Description?, (Numeric |

FixedRange) >

<!ELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ), ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>

(Numeric |

Description?, (Numeric

Map*) >

<!ELEMENT VariablePrimaryKey (Name,
| (AlphaNumeric, MaxLength?) | Date),

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment)>
<!--— The first Media will contain index.xml.

will process each media listed -->

Importing

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTFl6 | UTF7 | UTFS8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (VariablelLength | FixedLength))>

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn¥*) |
ForeignKey*) >

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >
<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date), Map*, FixedRange)>

<!ELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn¥*) |
(VariableColumn+) ), ForeignKey¥*)>

<!ELEMENT VariableColumn (Name, Description?, (Numeric |
(AlphaNumeric, MaxLength?) | Date), Map*)>
<!ELEMENT VariablePrimaryKey (Name, Description?, (Numeric
| (AlphaNumeric, MaxLength?) | Date), Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->
<!ELEMENT DataSupplier (Name, Location, Comment)>
<!-- The first Media will contain index.xml.
will process each media listed -->
<!'ELEMENT Media (Name, Command*, Table*, Command*,

AcceptNoTables?) >

Importing

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTF16 | UTF7 | UTES)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (Variablelength | FixedLength))>
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<!-- ForeignKeys denote joins or relationships between
tables.

To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
-—>
<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map 1s an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

<!-- ForeignKeys denote joins or relationships between
tables.

To successfully join two tables make sure both the
PrimaryKey and the referenced column (ForeignKey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
see line 35 for information about Alias -->
<!ELEMENT ForeignKey (Name+, References, Alias*)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and
because the Time data type was not defined yet we allow
specifying that an Alphanumeric

column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
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<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

If the application which interprets the xml and the
target application

to import into are able to deal with time data type
this column data could

be imported as Time data type

The value of the From element has to be equal with
the value of the To

element, in order to not be interpreted as an actual
Alphanumeric data mapping

in which the intention is to replace a certain text
with a different text at

import time, and be a valid Time format.

The following formats are recognized as valid Time
formats:

HH as symbols for hours

MM as symbols for minutes

SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if
needed.

Examples of valid formats:

HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS,
HHMMSSTT,

HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS
TT
-—>
<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Table 52: Comparison of default data structure version 1.1 and 1.6
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